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Note: The<Return>key on the keyboard is the same as the <Enter> key. 

 

Styles 

Styles are used to apply a particular format to a given piece of text (e.g. a heading, list item or 
quotation). This ensures that similar pieces of text are formatted in exactly the same way, thereby 
maintaining consistency within a single or between several documents. 

Word supports four types of styles: paragraph styles, character styles, table styles and list styles. 
Paragraph styles include both font (size, type, color, bold/italic) and layout (justification, line 
spacing) settings. Paragraph styles are, as might be expected, usually applied to whole 
paragraphs; however they can also be applied retrospectively as character styles to selected text 
(when only the font settings are activated). The default paragraph style is called Normal. 

Character styles are used for changing the format of a particular piece of text within a paragraph. 
They contain only font settings. The default character style is called Default Paragraph Font. Table 
styles contain cell border, shading and alignment (as well as font) settings. List styles contain 
numbering (or bulleting) settings (+ font etc) for each level in a list.   

There are many reasons for using styles, apart from consistency. Styles are simple to use and save 
you having to first turn on formatting and then turn it off again to return to normal. One paragraph 
style can be set to automatically change to another as you press the Return key to end a 
paragraph. You can define your own styles and/or modify the ones provided by Microsoft Word. If 
you modify a style in a document, all paragraphs or occurrences of text using that style are 
reformatted to reflect the new style. Finally, styles can be used to generate an Index and/or Table 
of Contents or Figures. 

Styles are associated with the document or template in which they are first defined. However it is 
possible to associate or merge styles from another document or template into the current one. 

Using the Default Paragraph Styles 

The styles currently defined for any document can be displayed by clicking on the list arrow 
attached to the [Style] button on the Formatting toolbar. Each style name is displayed in its own 
format, with the style type shown by symbols on the far right. Each paragraph has its own style 
setting. 

1. Start up Word or create a new document then click on the list arrow attached to the [Style] 
button (on the left of the Formatting toolbar) - the list of styles is displayed on the next page:  
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This shows four pre-defined paragraph styles (denoted by a paragraph mark ¶). These derive from 
the template being used for the document - in this case the default template, normal.dot. To use a 
style (e.g. Heading 1): 

2. Click on Heading 1 - the name in the style box will change from Normal to Heading 1  
3. Type in the words for your first heading - e.g. Exercise on Using Styles - the words will 

appear larger (16 point) and bolder than normal and in a different font (Arial)  
4. Press <Return> - the style name will automatically be reset to Normal  
5. Press <Return> again for a blank line then type in a couple of lines of ordinary text (You can 

use the shortcut =rand(1,4) <Return>  which will give you one paragraph with four sentences 
to use) (which appears in 12 point Times New Roman font)  

Paragraph styles can be applied at any time to a particular paragraph - they do not have to be set 
in advance of typing. To demonstrate this: 

6. Make sure the typing position is within the paragraph - press <Backspace> if necessary  
7. Click on the list arrow attached to the [Style] button again  
8. Choose Heading 2 - the whole paragraph will change to Arial bold italic 14 point  
9. Click on the [Style] list arrow again and choose Normal - the text will return to Times New 

Roman 12 point  

If you select part of a paragraph, you can apply a style to just the selected text: 

10. Select part of your normal text - a single word will suffice (double click on it)  
11. Click on the [Style] list arrow and choose Heading 2 - the text changes to Arial 14 bold italic  
12. Press the <right arrow> key to move away from the selection - note that the paragraph style 

still shows as Normal  
13. Click on the [Style] list arrow again but this time choose Heading 1 - the whole paragraph 

takes on the Heading 1 style except for the word(s) using the Heading 2 character style!  

Even if you select the whole paragraph and apply a new paragraph style, the words using the 
different character style remain different: 

14. Select the whole paragraph - the easiest way is to click three times anywhere within it  
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15. Repeat step 13 but this time choose Normal - again, only the paragraph style is effected (at 
least one word is still Arial 14 bold italic)  

To return the whole paragraph to normal, the current style settings must be cleared: 

16. Make sure the whole paragraph is still selected  
17. Click on the [Style] list arrow as usual but this time choose Clear Formatting - the whole 

paragraph should return to Times New Roman 12 point  

Hopefully, the above exercise has demonstrated the difference between a paragraph and character 
style. You can now go on to create your own styles and modify existing ones. 

Creating a Paragraph Style 

The easiest way to create a paragraph style is to copy it from a paragraph which has been set up 
exactly as required: 

1. Make sure that your paragraph is still marked - it must be selected when creating a style  
2. Apply the required formatting - here, you are going to set up a style for a quotation:  

i. Click on the [Italic] button  
ii. Click on the [Increase Indent] button towards the right of the Formatting Toolbar  
iii. Drag the Right Indent marker on the far right of the Ruler back to the 13cm mark  
iv. Press <Ctrl 0> to give an extra blank line before the paragraph  

3. Now click on the list arrow attached to the [Style] button  

You will find a new style has automatically been generated - the style settings are used to name it. 
This happens whenever you apply formatting to a paragraph (e.g. when you centre a heading). You 
could leave the new style name as it is but it's better to give it a sensible name: 

4. Type in the name for the new style, quote, and press <Return>  

A quote style has now been created and added to the list of available styles. To test it out: 

5. Click on the [Style] list arrow and choose Normal  
6. Press <Ctrl End> to move to the end of your work  
7. Press <Return> once to end the paragraph and start a new one  
8. Click on the [Style] list arrow and choose quote  
9. Type in a quotation - anything will do, a couple of lines will suffice  
10. Press <Return> to start a new paragraph  

You will find that the quote paragraph style is still set on - you will see later how to get it to revert 
automatically to normal. 
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11. Click on the [Style] list arrow and choose Normal  
12. Press <Return> once for a blank line and type another Normal paragraph  
13. Use this new paragraph to practice setting up another new style called mystyle, which uses a 

different font in a different point size, is double spaced and center aligned  
14. Test out your new style on the first (Normal) paragraph  

The Task Pane 

The Task Pane offers a host of useful features and makes working with styles much easier 
(although it does take up quite a lot of the screen). To display the Styles and Formatting task pane: 

1. Click on the [Styles and Formatting] button on the far left of the Formatting toolbar (or open 
the Format menu and choose Styles and Formatting...) - the task pane appears:  

 

4. As you move the mouse over the styles listed in the pane, formatting details are shown.  

Other Style Types 

Currently there are no character, list or table styles shown in the list of styles. You can display the 
other default styles via the Styles and Formatting task pane: 

1. At the bottom of the task pane, click on the list arrow attached to Show: and choose Custom... 
- the Format Settings dialog box appears:  
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2. In the list of Styles to be visible: turn on Default Paragraph Font - click in the check box  
3. Repeat step 2 for No List and Table Normal  
4. Note the other settings in this window then press <Return> for [OK]  
5. Examine the list of available styles attached to the [Style] button or in the task pane - note the 

symbols used to denote the different style types  

Character:      List:     Table:  

Generally there's no need to have these styles showing. To return to the original list: 

6. Press <Ctrl z> or click on [Undo]  

Microsoft Word has well over a hundred hidden built-in styles, some of which may appear in the 
style list as you issue certain commands - when you insert a table or list, for example. To see the 
available styles: 

7. Click on the list arrow attached to Show: and choose All styles  
8. Move up and down the style list in the task pane, just to see what's available  

Note: not all the styles are shown here - some only appear when they are needed - e.g. Table of 
Contents, caption and footnote styles. Don't forget that you can always turn off seldom-used styles 
in a list via Custom... 

9. To set the list just to the styles being used, repeat step 7 but choose Formatting in use - note 
that Heading 2 and 3 are missing  

10. Repeat step 7 again but choose Available styles - Heading 2 and 3 are back  
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Being able to customize the list of styles can be a very useful feature. It's all too easy to generate 
lots of styles, some of which are only used once or twice (remember that as soon as you apply 
formatting to a paragraph a new style is created automatically). You can prevent this happening by 
turning off the Keep track of formatting option, which is on the Edit tab when you issue an Options 
command from the Tools menu.  

Another useful feature of the Task Pane is that it lets you select all the text using a particular style. 
As an example, use it to change both mystyle paragraphs back to Normal:  

11. Move the insertion point into a paragraph using the mystyle style - this will show at the top of 
the task pane under Formatting of selected text  

12. Underneath this, click on the [Select All] button - this should select both paragraphs  
13. Now under the heading Pick formatting to apply in the task pane choose Normal - both 

paragraphs will have reverted to Normal  

Being able to select all the paragraphs (or text) using a particular style is very useful. For example, 
you may have used a style to format references in an essay in a particular way. You could then 
select them all and copy and paste them to give you a list of references. You might also want a 
word count excluding headings, tables etc. You can get that using this facility.  

Creating a Character Style 

Only paragraph styles can be created by copying the format of existing text. For other style types, 
you have to choose the settings required from a dialog box: 

1. Click on the [New Style] button at the top of the Task Pane - the New Style dialog box 
appears:  
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This dialog box can be used to set up a paragraph style; here, however, you are going to create a 
character style. A good example of a character style would be for Greek characters: 

2. Type in a Name: for the style - here, call it greek  
3. Change the Style type: to Character - note that paragraph settings are now greyed out and 

that the style is based on Default Paragraph Font, not Normal  
4. Under Formatting change the Font:  to Symbol (click in the currently empty [Font] box and 

type sym) and turn on [Italic]  
5. Make sure the Size: of the font is not set - if it is, drag through any value and <Delete> it  
6. Click on [Format] - here you can set up further Font characteristics and a Language and 

Shortcut Key... if you want (don't bother making any changes  - click again to close the menu)  

Note the Add to template check box which lets you add your new style to your normal.dot template 
(so it is available for all your documents). By default, styles are just saved in the current document. 

7. Click on [OK] to close the New Style dialog box and return to your document  

Now try out your new style: 

8. Select some normal text (a single word will do) then click on the [Style] list arrow and choose 
greek (or use the task pane) - the text will appear in italics in Symbol font  

You will remember that the new character style was set up without a fixed font size. Doing this 
enables the style to take on the font size set by the paragraph style. To demonstrate this: 

9. Repeat step 8 but on any word in your main heading - the word appears in greek but this time 
16 point (the same as the rest of the paragraph)  

10. Press <Ctrl z> on click on [Undo] to return the heading to its original state  
11. Press <Ctrl End> to move to the end of your work then <Return> twice for a new paragraph  

Creating a List Style 

Whenever you click on the [Numbering] or [Bullets] button, a list style is used. Again, you can 
create your own list style using the [New Style] button:  

1. Click on the [New Style] button in the Task Pane  
2. Type in a Name: for the style - here call it abclist  
3. Change the Style type: to List - the dialog box changes accordingly:  
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Note that Apply formatting to: is set up for the first level of your list. You can customise each level 
as you would like it but here, just change the one level: 

4. Click on the list arrow attached to the [Number style] button (currently shown as 1, 2, 3, ...) 
and select A, B, C... instead  

5. Press <Return> for [OK] to define the style  
6. Test out your style by choosing it and typing in a short list - press <Return> twice to end the 

list and return to Normal  

Creating a Table Style 

Table styles are quite complicated and few people make use of them. They can include settings for 
various recognised table elements such as the left/right column or the top/bottom row. In addition, 
there are a host of pre-defined table layouts, devised by Microsoft. 

As a simple demonstration of a table style, carry out the following exercise: 

1. Click on the [New Style] button in the Task Pane  
2. Type in a Name: for the style - here call it mytable  
3. Change the Style type: to Table - the dialog box changes accordingly:  
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4. Click on the list arrow attached to the [Shading Color] button (the one with the paint can) and 
select any colour  

5. Click on the [Borders] button list arrow (immediately to the right) and select Inside Borders  
6. Note that Apply formatting to: is set to Whole table - click on [OK] to define the style  
7. Test out your style by inserting a table into your document - click on the [Insert Table] button 

and choose a 2x3 table  
8. With the typing position inside the table, select mytable from the list of styles - the table should 

be coloured with the inner borders drawn  
9. Press <Ctrl End> or use <down arrow> to move out of the table  

Modifying an Existing Style 

You can modify an existing paragraph style, including those supplied by Word, in one of two ways 
as described below. For example, you may prefer Heading 1 to be centred: 

1. Press <Ctrl Home> to move to the top of your work  
2. Click on the [Center] button to centre your main heading  
3. In the Task Pane click on the list arrow which appears on the right of Heading 1 as you move 

the mouse over it and choose Update to Match Selection  

The style should now be redefined (centred). 

You can also modify an existing style using the Style dialog box. In fact this is the only way to 
change a character, list or table style. Some paragraph style settings (such as Widow and Orphan 
control and the style for the following paragraph) can also only be set this way. 
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4. In the Task Pane click on the list arrow on the right of quote and choose Modify... - the Modify 
Style dialog box appears:  

 

Note the Add to template check box (to add the modified style to the document template). Here, the 
Automatically update check box is also active. If you turn this on then any manual changes you 
make to a style are automatically added to the style settings (and all other paragraphs using this 
style will be changed to match). It's probably not a good idea to activate this as it's all too easy to 
add something by mistake. 

5. Click on the list arrow attached to the box on the right displaying ¶ quote under the heading 
Style for following paragraph:  

6. Select ¶ Normal from the list which appears  
7. Click on [Format] and choose Paragraph...  
8. Under the Spacing heading, set After: to 12 pt, which will automatically add a blank line after 

the quote (to match that before)  

Note: Widow/Orphan control is set up here on the Line and Page Breaks tab. 

9. Press <Return> or click on [OK] to return to the Modify Style box  
10. Press <Return> or click on [OK] to save the modified style  
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You should find that you now have an extra blank line you don't need below your original quote 
paragraph, which you can delete. 

10. Press <Ctrl End> to move to the end of your work and try out the redefined style by typing in a 
new quote - note how the style now returns to Normal when you press <Return>  

Note: You cannot modify the Default Paragraph Font, the No List or the Table List styles. You can, 
however, change the font used by the Normal paragraph style if you prefer a different font to Times 
New Roman. If you do redefine the font in this way then all your other styles based on Normal (here 
mystyle, abclist and mytable) will automatically change to match it. 

Deleting a Style 

To delete an existing style: 

1. In the Task Pane, click on the list arrow on the right of the style you no longer require - here 
select mystyle  

2. Choose Delete... - you are now asked to confirm the deletion  

 

3. Click on [Yes] to confirm the deletion (or [No] if you decide you want to keep it)  

The Format Painter 

Format Painter:  

Styles can be copied from one piece of text and applied to another using the Format Painter. A 
special button for this is provided on the Standard Toolbar, immediately after the cut/copy/paste 
buttons. 

1. Drag through some greek text to select it (a few characters will do)  
2. Click on the [Format Painter] button - the mouse cursor becomes a little brush  
3. Drag through some non-greek characters  

When you let go of the mouse you will find the selected characters become greek - the special 
character style is applied to them. If you need to do this repeatedly: 

4. With some greek text selected, double click on the [Format Painter]  
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5. Drag through some non-greek characters - they will become greek, as before  
6. Drag through other areas of text - they also will become greek  
7. When you have finished, turn off the [Format Painter] by clicking on the button once  
8. Use <Ctrl z> or click on [Undo] to reverse the changes, if you don't want them  

Paragraph styles can be painted in exactly the same way. To copy the paragraph style, the whole 
paragraph must be selected before the Format Painter is used: 

9. Select a quote paragraph - the easiest way is to click three times within it  
10. Click on the [Format Painter] button - once to copy the style to a single paragraph or twice to 

copy the style repeatedly  
11. Click on one of the abclist paragraphs - that too will become a quote  
12. Press <Ctrl z> or click on [Undo] to return the paragraph to a list  

Note: if you drag through just part of the paragraph then only the font settings are painted across 
and the paragraph will retain its original layout. 

Copying Styles Between Files 

It is easy to merge the styles from one document into another (new or an existing one). However, if 
you want to merge styles into a document you are currently working on it then must be saved first. 
In this next exercise, you are going to copy your quote style into a new document: 

1. Click on the [New] button for a new blank document  
2. Click on the [Save] button and name the file tempstyle - press <Return> to [Save] it  
3. Look at the task pane or click on the [Style] list arrow and note which styles are available  

You should find that none of the styles you have created or modified are available to you - you only 
have the default styles (the ones you created have not been added to normal.dot). To copy a style 
from the document you have been working on: 

4. Move to your original document (Document1) via the Window menu  
5. Open the Tools menu and choose Templates and Add-Ins...  
6. Click on [Organizer...] at the bottom left of the Templates and Add-ins dialog box  

The Organizer dialog box will open with the current document's styles listed on the left and the 
styles in Normal.dot (the default template) on the right. 
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The current configuration allows you to copy Styles from your document to the normal.dot template. 
Other tabs are provided to copy AutoText entries, Toolbars and Macros between templates and 
documents. Note that AutoText can only be copied between templates. To copy to a template or 
document other than Normal.dot: 

7. Click on the [Close File] button on the right hand side (to close Normal.dot)  
8. Now click on the same button which has been renamed [Open File...]  
9. Change the Look in: directory to My Documents (click on the button at the left)  
10. Change Files of type: to Word Documents (*.doc) to move the styles between documents  
11. Select tempstyle.doc and press <Return> for [Open]  
12. Select the style(s) to be copied (here choose quote) from the left-hand box then click on the 

[Copy >>] button  

Note that you can select more than one style by using <Shift click> and <Ctrl click> as in other 
dialog boxes in Windows. 

13. Now [Close] the Organizer dialog box  
14. Move back to your tempstyle.doc via the Window menu  
15. Look at the task pane or click on the [Style] list arrow and note which styles are now available 

- you should find quote has been added to the list  
16. End by closing tempstyle.doc - from the File menu choose Close or click on the [Close 

Window] button. When asked, save the changes to tempstyle.doc - click on [Yes]  

By changing the To: and From: options in Organizer you can copy styles etc between any of your 
documents or templates. You don't even have to have either of the files open when you do this 
(both files were kept open in the above exercise so that you could see what was happening). 


